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1. OPC Server - Siemens SPC

What is OPC?

OPC (Open Platform Communications) is the world-wide recognized quasi-standard for communication
between almost all facilities in building and security technology. Schille Informationssysteme GmbH has been
a specialist for OPC technologies in the security industry for more than 15 years.

Description

The OPC server Siemens SPC is designed to communicate with Siemens SPC series intrusion detection systems.
This is done via the Enhanced Datagram Protocol (EDP) using TCP / IP.

Among other things, statuses are provided via door and window contacts or alarms as data points, which are
read by the OPC server and are, Can also be described.

All status changes of the SPC systems are transferred via so-called SIA events.

The OPC server only supports the connection of a control center. If several control panels are to be integrated,
several instances of the OPC server are also required on one device.

Technical data

OPC Specification: OPC DA 2.0

Compatibilty: SPC firmware 3.4; EDP Protocol Specification 2.5

Interface: Ethernet

Protocols: EDP über TCP/IP

Features

The following states can be read / written by the OPC server:

•  Door / window contact on / off / open / closed / sabotaged
•  Burglar alarm on / off / test mode
•  Alarm delay on / off
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1.1. User Manual OPC Server - Siemens SiSPC
 
 



OPC Server - Siemens SPC
Installation, Configuration, Usage

User Manual
V1.2 / 22.03.2018

Page 4 from 24

Revision
 
Version Created Version  Number Remarks

1.0 27.05.2014  Created

1.1 02.07.2014  The events BA / BR as well as the switching command
"RestoreAlerts" are new.

1.2 22.03.2018  Siemens SPC screenshots exchanged
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1.1.1. Installation, startup and exit

The OPC server requires no installation. The program can basically be executed from any program path.

The OPC server is started with the appropriate exe file. The program starts minimized and can be displayed
via the system tray.

It should be noted that the program path in the operating system must be registered for an OPC client access.
This is done via the interface of the OPC server. For this purpose, the menu item OPC-> Register OPC Server
must be selected.

To terminate the program, click on the red X in the upper right corner, or in the menu item File -> Close. The
File menu also contains the Hide command, which allows the OPC server to be minimized to the system tray.

The configuration is later read out online from the device. Up to this time, a window appears at the start,
indicating the missing configuration:
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1.1.1.1. Multiple instances of the OPC server

The OPC server only supports the connection of a control center. If more than one control center is
to be connected, several instances must be registered and started on a computer. In the following, the
SiSpcOPC server is always spoken. Each further instance is then appended to the consecutive number, eg
"SiSpcOPCServer02". The same applies to the Ini or Dat file.

Important: A separate license has to be purchased for each instance.
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1.1.2. Graphical Interface

The graphical interface is divided into three sections:

1. Hierarchical tree view of data structure

The entire data structure is displayed here. An element is marked with a left mouse click and the data points
that may be contained are displayed on the right side. The subordinate elements can be opened by double-
clicking.

2. Overview of the included data points

In this area, the data points of a selected element are displayed in tabular form. The following information
is displayed for each data point:

•  Item     Data point name
•  Name     Here, a help text is usually displayed for better identification
•  Type     Data type of the data point
•  Value     The current data point value

Note: The Value column is disabled by default. It can be displayed via the menu item Data -> Display.
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3. Communication logbook

The logbook is deactivated by default and can be displayed via the menu item Data -> Logbook.

The entire communication is displayed in the logbook. The Clear button deletes the contents of the logbook
window. The ASCII code can be activated using the ASCII checkbox. The checkbox Stop suppresses further
entries in the logbook window. When the checkbox Log to file is checked, all other entries are written to a
text file. The file has the same name as the OPC server, but has the file ending .LOG.

The menu line provides access to the following entries:

Menu Item Function

FileHide Minimizes the program to the system tray

FileClose Terminates the program

SettingsConfiguration Settings for the OPC server

OPCRegister Registriert den OPC Server im Betriebssystem

OPCRemove OPC Server
Registration

Removes the existing OPC server registry

OPCProtocol Writes a log file to the OPC interface

OPCClose Clients Terminates all connections to connected OPC clients

DataLogbook Show or hide the logbook

DataDisplay Show or hide the data point values

DataWrite Opens an input mask to assign a value to a selected data point

…Licensing Opens the licensing dialog

…about Provides information on the version number etc. of the OPC server

The status line displays the clients and subscribed groups connected to the OPC server as well as the runtime
of the OPC server. If the OPC server is started in demonstration mode, the remaining runtime is displayed.
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1.1.3. Licensing the OPC Server

All products of Schille Informationssysteme GmbH are licensed according to the same scheme. Therefore, this
is described in a separate document which is available for viewing or downloading on the Internet:

http://www.schille.com/downloads/documents/documentations/SiDOC-20140603-de-procteron-
lizensierung-anleitung.pdf

The internal product key is "O04-014-01" and will be "OPC Siemens SPC Intruder" if a current product.xml
file is present.

After successful licensing and subsequent restarting of the OPC server, the current runtime of the OP is
displayed in the status bar:

http://www.schille.com/downloads/documents/documentations/SiDOC-20140603-de-procteron-lizensierung-anleitung.pdf
http://www.schille.com/downloads/documents/documentations/SiDOC-20140603-de-procteron-lizensierung-anleitung.pdf
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1.1.4. Configuration of the OPC server

The configuration of the OPC server is done online, which means that the configuration of the OPC server
is read out from the SPC. Accordingly, the communication must first be established. This is done by the SPC,
which cyclically tries to reach the OPC server. For this reason, the OPC server must first be informed of the
network address and port on which it is to be made. This is done via the ini file of the OPC server (area [TCP]),
which is described in more detail in the next section. After the change, the OPC server must be restarted.
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1.1.4.1. Structure of the INI file

[DIALOG]   

 Param Transfer of possible start parameters

 Language Language of the graphical user interface

 Logging Enable / disable logging

[TCP]  Settings for the interface to the SPC

 IP TCP / IP address on which the SPC tries to establish the
communication, eg IP = 192.168.2.101

 Port Port on which SPC attempts to establish communication, eg port =
50000
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1.1.4.2. Read the SPC configuration

After the OPC server has been started, the configuration dialog must be called up via the menu item "Settings /
Configuration". In the following figure, the SPC has not yet recorded any communication, so no read-out is
possible and the buttons are deactivated.

If the SPC has recorded the communication, the zones, zones and doors can be read out.

The data obtained from the SPC are stored in the file "SiSpcOPCServer.dat" in the directory of the OPC server.
A separate area is created for each type of supported groupings (area / zones / doors).
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In the following table, a sample configuration from the test environment:

[AREAS]
00001=Area 1 Area ID + Names (assigned by SPC)

00002=Area 2

[ZONES]
00003=Window 2 Zone ID + Names (assigned by SPC)

00004=PIR 1
00010=Door 1

[DOORS]
00001=Door 1 Door ID + Names (assigned by SPC)
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1.1.5. Features of the SiSPC OPC server

The range of functions is currently based on the WEB interface of Siemens, whereby, for example, logbooks
can not be displayed within the OPC server.
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The state is reflected in the "State" data points:

Switching commands can be sent via the control commands to the SPC, regardless of the value transferred.
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1.1.5.1. SIA events

All status changes are transmitted via so-called SIA events. A list of all possible events is available within
Siemens.

Important: The documentation may not be passed on by the company Schille Informationssysteme GmbH
and is therefore to be procured independently.

The following events are processed in the version of the OPC server:

BA / BR / DC / DD / DF / DG / DO / DR / DX / CG / OG / NL / BB / BU / ZO / ZC / YT / YR

Important: An extension for further events is possible. However, a test system or telegram messages may be
required.

These events must be enabled separately within the SPC, otherwise no notification from the SPC is made to
the OPC server. Some screen shots of the settings from the test environment can be found without comment
at the end of this document.
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1.1.5.2. The data point „SiNEO“

The "SiNEO" data point is the numeric value of the state of the data point. It is based on a 64bit key, which is
defined within the document "SiNEO-Codes", and thus determines the symbols within the SiVMS-Command
versions.

The following is a small excerpt:
 
4096 0000-0000-0000-1000 Switched off Bright orange 0xffc800

65536 0000-0000-0001-0000 Alarm Red 0xff0000

16777216 0000-0000-0100-0000 Failure Gray / red crossed  

536870912 0000-0000-2000-0000 Unlocked Bright violet 0xff80ff

4294967296 0000-0001-0000-0000 Disruption Yellow 0xffff00

 
The document "SiNEO-Codes" can be obtained separately.
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1.1.5.3. The data point „Triggered“

This data point is set for 1 second for each event that can be assigned to this area, zone or door. Whether or
not the value changes with a data point.

The background is that a recording is to be started when an access card is detected on the reader. The value of
the data point "Access" changes only if a valid valid card is detected after a valid, or after an invalid, valid card.
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1.1.6. Screenshots of the SPC settings
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1.1.6.1. EDP settings
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1.1.6.2. Filter settings



OPC Server - Siemens SPC
Installation, Configuration, Usage

User Manual
V1.2 / 22.03.2018

Page 24 from 24

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The information in these documents may be changed without prior warning. This manual may not be
duplicated or disclosed to third parties in full or in part without the prior written agreement of Schille
Informationssysteme GmbH.
 
© 2018 Schiille Informationssysteme GmbH / Schille Services GmbH.
 
All rights reserved. We reserve the right to make technical alterations. All products mentioned by name are
trademarks or registered trademarks of their respective manufacturer.
 
The documentation describes -  OPC Server - Siemens SPC - Installation, Configuration, Usage - V1.2 -
Modified version dated  22.03.2018


	OPC Server - Siemens SPC
	1. OPC Server - Siemens SPC
	1.1. User Manual OPC Server - Siemens SiSPC
	Revision
	Table of Contents
	1.1.1. Installation, startup and exit
	1.1.1.1. Multiple instances of the OPC server

	1.1.2. Graphical Interface
	1.1.3. Licensing the OPC Server
	1.1.4. Configuration of the OPC server
	1.1.4.1. Structure of the INI file
	1.1.4.2. Read the SPC configuration

	1.1.5. Features of the SiSPC OPC server
	1.1.5.1. SIA events
	1.1.5.2. The data point „SiNEO“
	1.1.5.3. The data point „Triggered“

	1.1.6. Screenshots of the SPC settings
	1.1.6.1. EDP settings
	1.1.6.2. Filter settings



	Copyright Schille Informationssysteme

